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Experiment 6:    Spectrophotometric Determination of 
Iron in a Vitamin Tablet 

Objective:  In this experiment, you will use the quantitative technique of 
spectrophotometry to determine the mass of iron contained in a commercially available 
vitamin tablet. 

Introduction 

Iron and the Human Body 

 The element that is found in the fourth greatest abundance in the earth’s crust is 
also encountered everywhere in biological systems.  These two facts about iron are not 
unrelated as nature has found it logical to adapt this plentiful element to perform a variety 
of functions.  The fact that iron has two readily accessible oxidation states, Fe(II) and 
Fe(III), also contributes to its usefulness as an active component of proteins. 

 The average adult human body contains 4-6 g of iron.  In human beings, the 
majority of iron present is found in the blood in a protein called hemoglobin.  The 
function of this protein is to transport oxygen from the lungs to the various tissues in the 
body where it is used to produce energy.  One of the byproducts of this metabolism, 
carbon dioxide, is then transported back to the lungs by hemoglobin. 

 Humans obtain the iron necessary for the formation of hemoglobin from their diet 
in foods such as meat and leafy, green vegetables.  When the dietary intake is deficient in 
iron, a condition called anemia results.  Someone who is anemic exhibits a lack of energy 
and often unusually pale skin tone (the red color of blood is also a result of the presence 
of iron in hemoglobin).  Dietary supplements of iron in the form of vitamin tablets can be 
administered to help alleviate this condition.  The tablets you will examine contain iron in 
the form of ferrous fumarate, [Fe(II)(C4H2O42–)]. 

Spectrophotometric Analysis 

 One of the most common techniques used in the quantitative analysis of samples 
for a specific chemical substance is called spectrophotometry.  In spectrophotometry, 
the amount of electromagnetic radiation absorbed by a sample is measured with an 
instrument called a spectrophotometer, and this absorbance is related to the 
concentration of the species for which the sample is being analyzed.  When a source of 
visible radiation is used, the relationship between absorbance, A, and concentration, c, is 
known as Beer’s law: 

 A = εcl Eq. 1  

In this equation, the concentration is expressed in molarity.  Molarity is represented by a 
capital, M (see Tro, pp 152-154): 

 molarity = M = number of moles of solute in the solution Eq. 2 
 volume of solution in liters 
 
Thus, the number of moles of solute present in a solution can be calculated in the 
following manner: 
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 number of moles solute = (molarity)•(volume of solution in liters) Eq. 3 

The other variables in Beer’s law are:  ε, a constant that is a characteristic of the 
absorbing species called the molar absorptivity, and l, the length of the absorption cell 
that contains the solution.  You should read all of Section V. in the Techniques section of 
the lab manual/notebook to understand fully the instrumentation and principles involved 
in measuring the absorbance of a solution.  

 Because the molar absorptivity value is not always a known quantity, a 
calibration curve is often constructed from a series of standard solutions.  A standard 
solution is one in which the concentration of the species being analyzed is known.  The 
absorbances of several standard solutions are measured, and these values are plotted as a 
function of the concentrations of the solutions.  If the absorbing species behaves 
according to Beer’s law, such a plot should produce a straight line (see Eq. 1).  The 
absorbance of a solution of unknown concentration can then be measured with the 
spectrophotometer, and this value can be used in conjunction with the calibration curve to 
determine the concentration of this solution.  Read Section IV in the Techniques section 
to find out more about straight line graphs (p. 36) and Excel (pp 39-43), especially the 
LINEST function. 

Analyzing for iron spectrophotometrically 

 In this experiment, you will spectrophotometrically analyze a commercially 
available vitamin tablet in order to determine the quantity of iron that is contained in the 
tablet.  To do this, the iron will first be converted into a form that absorbs radiation in the 
visible region.  This conversion will be done by reacting the iron with an organic 
compound called 1,10-phenanthroline.  The structure of this molecule is shown in  
Figure 1.  It reacts with Fe(II) to form an ionic compound that contains one iron ion and 
three 1,10-phenanthroline molecules (the structure of this compound is also shown, in 
Figure 2).  The color of this compound in solution is bright red-orange; consequently, it 
absorbs light very strongly in the visible region at a wavelength of 508 nanometers (see 
Tro, pp 1144-1145 and also the visible spectrum on page 302). 

 You will react 1,10-phenanthroline with a vitamin tablet that has been dissolved 
in hydrochloric acid.  In order for this reaction to occur, the iron ions that are present 
must be in the Fe(II) oxidation state.  Since Fe(II) is easily oxidized to Fe(III) in the 
presence of acid and water, a reducing agent called hydroquinone is added to the solution. 
In addition, it is important that the acidity of the solution is carefully controlled or 
compound 1 will not form; the presence of sodium citrate in solution will neutralize some 
of the acid and maintain the proper pH.  The resulting solution will be diluted to an 
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Figure 1.  The structure of 1,10-phenanthroline 
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Figure 2.  The structure of the iron-1,10-phenanthroline compound, 1. 

appropriate concentration and its absorbance measured.  A spectrophotometric calibration 
curve will then be constructed from a series of standard solutions that contain known 
concentrations of the iron–1,10-phenanthroline compound (1).  The concentration of iron 
in your sample solution, and thus the amount of iron contained in the vitamin tablet, can 
subsequently be calculated.  
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Procedure 

Preparing the “original” iron solution 

 Grind a vitamin tablet with a mortar and pestle (it does not have to be finely 
ground).  Obtain 25 mL of 6 M hydrochloric acid in a 150 mL beaker and place the 
ground vitamin tablet in this solution.  Swirl the beaker and wait a few minutes for 
evidence of a reaction.  After the initial reaction has subsided, place the beaker on a hot 
plate in a fume hood, cover with a watchglass and heat to boiling.  Boil the mixture for 
15 minutes.  You may need to add more deionized water during the boiling period if the 
volume falls below about 15 mL.  Remove the beaker from the hot plate and rinse the 
bottom of the watchglass using a wash bottle, catching the rinse water in the reaction 
beaker.   

 Filter the solution while still warm by gravity filtration (see TECH I.G) directly 
into a 100 mL volumetric flask.  Rest the funnel in a wooden funnel holder.  While the 
solution is filtering, heat some deionized water in a 250 mL beaker on a hot plate.  When 
the filtration is completed, use small amounts of this hot water to rinse out the beaker, 
pouring the rinse water on the solid residue contained in the filter paper such that it filters 
into the 100 mL volumetric flask.  Then use small amounts of the hot water to wash the 
residue two more times.  Be careful not to overshoot the mark on the volumetric flask 
with these rinses.  Turn off the hot plate. 

 Allow the solution in the volumetric flask to cool to room temperature, then dilute 
to the mark with deionized water (see TECH II.G) and mix.  Be sure to add the final 
amount of water to the volumetric flask with a dropper so that you do not overshoot the 
calibration mark!  This solution in the volumetric flask is what we will call the “original” 
iron solution.  Pour this solution into a clean, dry 250 mL Erlenmeyer flask, label it with 
the words “Original Iron Solution” and set aside.  Rinse the volumetric flask three times 
with small portions of deionized water, discarding the rinses into the sink.   

The first dilution 

 Obtain a 5 mL volumetric pipet and rinse it two or three times with small portions 
of the solution contained in the Erlenmeyer flask (see TECH II.D).  Pipet 5 mL of the 
iron solution into the volumetric flask, dilute to the mark with water and mix.  Label the 
volumetric flask “Flask A”.  [Set aside the Original Iron Solution in case you make a 
mistake during the dilution procedures.  When you are finished with the experiment, pour 
this solution into the Laboratory Byproducts jar labeled Iron  + HCl.]  

Determining the amount of sodium citrate required to maintain the proper pH 

 Obtain a 10 mL volumetric pipet and rinse it two or three times with small 
portions of the solution contained in Flask A (the volumetric flask).  Label a clean, 
dry 125 mL Erlenmeyer flask “Flask B”, then pipet 10 mL of the solution in Flask A into 
Flask B.  Obtain about 8 mL of sodium citrate solution in a graduated cylinder and a strip 
of indicator paper.  Add the sodium citrate solution dropwise to the solution in Flask B, 
counting the drops as you add them.  After you have added 10 drops, test the solution 
with the indicator paper.  The paper should turn yellow-green, indicating that a pH 
between 3 and 4 has been reached (a color chart will be available for comparison 
purposes).  If a pH lower than 3 is indicated, continue to add sodium citrate solution 
dropwise, checking the solution with the indicator paper after every four or five drops 
until the proper color is reached.  If a pH higher than 4 is indicated, start over with a new 
10 mL aliquot of the solution from Flask A, and add less than 10 drops of sodium citrate 
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before testing the pH.  Record the total number of drops of sodium citrate that were 
required to reach a pH of 3 to 4 in your notebook. 

The second dilution and conversion of iron to the iron-1,10-phenanthroline compound 

 Label a clean, dry 250 mL Erlenmeyer flask “Flask C”.  Pour the contents of  
Flask A into Flask C and set aside.  Rinse the volumetric flask (Flask A) with deionized 
water (discard the rinses in the sink).  Pipet 10 mL of the solution in Flask C into the 
volumetric flask.  Add the same number of drops of sodium citrate that were required to 
properly neutralize the solution (the number recorded in your notebook).  Then add  
2 mL of hydroquinone solution and 3 mL of 1,10-phenanthroline solution to the 
volumetric flask and swirl.  Dilute to the mark with deionized water and mix thoroughly.  
Let this solution stand for at least 15 minutes before measuring the absorbance.  [You 
may discard the contents of Flasks B and C in the sink.] 

Preparing the calibration curve and measuring the absorbance of the sample solution 
(you do not need to outline instructions for using the LoggerPro software) 

 See TECH Section V (pp 44-45) for instructions on how to use a spectrophoto-
meter and especially how to fill a cuvet.  Note: never put acetone into a cuvet as it will 
“cloud” the plastic.  You and one other student will be assigned to use a computer with a 
SpectroVis Plus (SVP) device.  You must measure the absorbances of all the standard 
solutions using the same SVP, and later you must also use this SVP to measure the 
absorbance of your own sample solution.  

Be careful!  If you spill liquid in the SVP, the instrument will no longer function. 

In the Applications folder, click on the button labeled Logger Pro.  You will 
calibrate the SVP spectrophotometer using deionized water as a blank.  From the 
Experiment menu, choose Calibrate followed by Spectrometer: 1.  Wait 90 seconds 
for the lamp to warm up.  Fill a clean dry cuvet with deionized water until the liquid is at 
the line below the inverted triangle, then place it in the SVP.  Be sure the inverted 
triangle on the cuvet is next to the white triangle that is painted on the box.  When the 
warm-up is completed, click on Finish Calibration.  When the calibration is completed, 
click on OK. 

Click on the Configure Spectrometer button in the toolbar:    

In the dialog box that appears, click in the circle next to Absorbance vs. Concentration. 
On the left-hand side of the box, type in Concentration under Column Name:, Conc 
under Short Name: and mol/L under Units:.  Scroll through the listing in the center of 
the box to find the number that is closest to 508 nm.  Click in the appropriate box to 
place a √ next to this wavelength.  Choose Single 10 nm Band from the drop-down menu 
on the left.  Click on OK.  

Each pair assigned to a computer and SVP must obtain the absorbance readings of 
the standard solutions using their instrument.  The standard solutions contain the iron-
1,10-phenanthroline compound, 1, in water at the following concentrations:   
0.500 x 10-5 M;  1.00 x 10-5 M;  2.00 x 10-5 M;  3.00 x 10-5 M;  5.00 x 10-5 M 

 Click on the green arrow button.  A circular button that is blue will appear next 
to the red rectangle.  Rinse the cuvet with three small portions of the solution you wish 
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to measure, then fill the cuvet and place it in the SVP.  Watch the absorbance reading that 
appears in the lower left corner of the screen (below the table).  When the absorbance is 
stable, click on the blue button.  In the box that appears, type in the value for the 
concentration of the solution (no units) and click OK.  Use the letter “e” to designate the 
exponent.  For example, 1.00 x 10-5 can be written: 1e–5.  Repeat until you have 
measured the absorbances for all the standard solutions. 

When you have acquired absorbance readings for all of the standard solutions, 
click on the red rectangle to stop the data collection.  Save the data to the Documents 
folder.  

Important step!  Saving your data: 
• Save your data by pulling down the File menu and selecting Save As... 
• In the dialog box that appears, the word Documents should be displayed in 

the drop down menu in the middle of the box.  If it is not, scroll through the 
menu on the left, and choose Documents. 

• Next to the words Save as:, type over the word “untitled” with the name of 
your file (example: IronCalibrationLAO).  You should include your initials in 
the name you choose. 

• Click on Save.   
• To find your file later, you will have to go to the Documents folder.  It should 

have the suffix .cmbl at the end of the file name. 

 Open the Excel program.  Place your cursor in the first cell (A1) and type the 
word Concentration with the units in parentheses. You can label the next column (B) 
with the heading Absorbance.  Go back to the LoggerPro screen.  Click and drag to 
highlight all the data in both columns of the data table.  Once these values are 
highlighted, select Copy from the Edit menu.  Go back to the Excel screen.  Click in cell 
A2.  Select Paste from the Edit menu, and all the data should appear in columns A and 
B.  At this point, you should save the spreadsheet to the Documents folder.  

 You need to make a new “blank” solution to calibrate the spectrophotometer 
before measuring your sample solution.  Place one drop of sodium citrate solution, one 
drop of hydroquinone solution and one drop of 1,10-phenanthroline solution into a cuvet 
that has been thoroughly rinsed with water.  Dilute almost to the top of the cuvet with 
deionized water, and stir gently with a small stirring rod.  Use this solution to calibrate 
the instrument (under the Experiment menu).  Rinse and fill the cuvet with your sample 
solution (the contents of the volumetric flask).  Place it in the SVP, and record in your 
notebook the absorbance value that appears in the lower left corner of the screen.  

 Pour the final sample solution (in the volumetric flask) and the standard solutions 
into the Laboratory Byproducts jar labeled Iron-1,10-phenanthroline.  Discard the 
Original Iron Solution into the Laboratory Byproducts jar labeled Iron  + HCl. 

E-mail the Excel spreadsheet that you saved in the Documents folder to yourself.  
For Calculation 1, you will plot and analyze this data using the LINEST function. 
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Calculations 
 

1.  Plotting and using the calibration curve 
• Use the program Excel to plot the calibration curve (see TECH IV, pp 39-43).  

Follow the instructions to draw the “best fit” line through the data points.   
• Use the LINEST function to determine the slope and y-intercept.  Follow the 

instructions in TECH IV to find the concentration, in molarity, of your sample 
solution using Excel.   

• Print the plot and data table, and hand them in with your report. 

 
2.  Determining the amount of iron in the tablet 
• Calculate the concentration of iron in your original iron solution (the solution 

in the volumetric flask that was obtained after the boiling and filtration steps) 
in molarity.  Remember, there are 2 dilution factors!  See Tro, pp 154-156 for a 
discussion of dilution calculations.  In this case, the unknown quantity is the 
initial molarity.   

• Knowing the concentration of your “original” iron solution, you can now 
calculate the number of milligrams of iron in the vitamin tablet (see Eq. 3).  

 
Questions 
 

1. The presence of a dirty fingerprint on the cuvet during measurement of the 
sample solution resulted in the number of milligrams of iron per tablet being 
reported incorrectly.  Do you think the number reported was too high or too 
low?  Explain why. 

2.  Is your calibration curve a good example of Beer’s law?  Why or why not?  
Calculate the value for molar absorptivity, ε, based on the calibration curve 
that you prepared.  Assume the length of the cell, l, is 1.00 cm.  Be sure to 
include the units! 

3.  List the important sources of error in this experiment and what effect each 
would have on the results.  Discuss in particular any errors that you may have 
made. 

 


